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1 Introduction

This document is the manual for Praat Launcher, a Microsoft Excel Add-in
that launches Praat1 from Excel worksheets2.

If you are new to Praat Launcher, check out the tutorial (tut prln.pdf)
before you read on; it is available at:

http://language.world.coocan.jp/scripts/?PraatLauncher

2 Basic Functions

Praat Launcher opens a set of files (TextGrid and/or Sound files) with
Praat TextGrid/Sound Editor, based on the values specified in Excel work-
sheets and/or the default values predefined in the Excel add-in.

More specifically, Praat Launcher searches the active row of the current
worksheet for the basename of TextGrid/Sound files and two timestamps
[timestamp 1 and 2] (see Figure 1). The default columns for the basename
and the timestamps are A, B, and C (the columns can be changed; see §9.4).

1http://www.fon.hum.uva.nl/praat/
2 For the version of Praat Launcher this document is based upon, see Appendix B.

http://language.world.coocan.jp/scripts/?PraatLauncher
http://www.fon.hum.uva.nl/praat/


Praat Launcher: Manual 4

Figure 1: Execution of Praat Launcher (on Row 52)

Timestamp 2 is optional; if the value of timestamp 2 can be interpreted as
the end time (and the value of timestamp 1 as the start time), then Praat
Launcher assumes that the interval (from timestamp 1 to timestamp 2) is
specified; otherwise, it assumes that the point (only the value of timestamp
1) is specified.

In addition to the basename and timestamps, Praat Launcher utilizes
values of various kinds of parameters (directories of the files, margins on
the Editor, . . . ; for the list of the parameters, see §9). The parameters
are set to either (i) the values on the Setting Sheet (a special worksheet
named “SheetSetting”) if it exists in the current Excel Book, or (ii) the
default values defined in the Add-In if otherwise. The Setting Sheet is created
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by selecting Praat Launcher’s menu Setting → SettingSheet3. Since the

Figure 2: the Setting Sheet

initial values in the Setting Sheet is the default values, you have to rewrite
the values on the Setting Sheet (Column D) to suit your environment. If the
default values are optimal to your environment, you do not have to create a
Setting Sheet (see Appendix A.1).

3 How to Launch

To start Praat from an Excel worksheet, select a command in the Praat
Launcher’s menu Praat.

The most basic command is TextGrid+Sound, which opens a pair of
TextGrid and Sound files. But Praat Launcher provides the means to open
either Sound or TextGrid file alone (Sound and TextGrid in the menu).

For commands whose names contain “[suffix1]” and “[suffix2]”, see
§7.

Some commands are also executable with shortcut keys (see figure 3
above; “(C-S-v)”, for example, means “to hold down Ctrl and Shift, and
type v”), and via the (right-)click menu (see figure 4 below).

3In Excel 2007, the menu will be available by clicking Excel’s “Add-Ins” tab.
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Figure 3: Praat Launcher Menu: Praat

4 Data Sheet

Praat Launcher requires not only TextGrid/sound files but also a Data Sheet,
a worksheet containing filebasenames and timestamps, on which it is exe-
cuted.

Preparation of the Data Sheet, although important, is is beyond the scope
of this document. The present author uses Praat scripts to convert TextGrid
files into tab-separated (and usually KWIC-formatted) text files (cf. the
sample files utilized in the tutorial [tut prln.pdf]).

5 Setting Sheet

The Setting Sheet is an Excel worksheet named “SheetSetting”, used to
set the parameters of Praat Launcher (for the list of the parameters, see §9).
It is created by selecting Praat Launcher’s menu Setting→ SettingSheet.
If there is no Setting Sheet in the current Book, Praat Launcher uses the
default values for the parameters.

Praat Launcher is provided with the function of automatic update of
Setting Sheet; if Praat Launcher encounters a Setting Sheet with an obsolete
format (created by an older version of Praat Launcher), it will automatically
update the sheet to the current format. The values on the existing Setting
Sheet will be passed to the new one. The existing Setting Sheet is preserved
under the name “PraatSetting OLDx” (where “x” is a number). If it is
unnecessary, delete it manually.

If the Setting Sheet is unrecognizable to Praat Launcher (for example,
in the case that the Setting Sheet was created by a newer version of Praat
Launcher), you have to (i) delete (or rename) the current Setting Sheet man-
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Figure 4: (Right-)click Menu

ually, (ii) make a Setting Sheet by selecting Setting → SettingSheet, and
(iii) rewrite the values.

6 Restrictions

Praat Launcher was designed not to get in the way of Praat and Excel; the
functions of these applications should be fully available. There are, however,
two things which Praat can do while Praat Launcher cannot.
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6.1 Prohibition of the Creation of homonymous TextGrid
Objects

The first and more important restriction is:

Restriction 1:
Praat Launcher does not create a new TextGrid Object if there is al-
ready a TextGrid Object with the same name in the Object Window;
instead, it tries to open the already existing one with TextGridEditor.

This restriction is deliberate, and in most cases it yields satisfactory results.
The motivation for this is to guarantee that all modifications made on dif-
ferent TextGridEditors should be reflected in the same TextGrid file.

Suppose that you created two TextGrid Objects from one and the same
TextGrid file, and made different modifications to the two Objects on dif-
ferent TextGridEditors. Suppose further that you saved the two Objects
(say, Object1 and Object2) as TextGrids one at a time. Then, the resultant
TextGrid would be the Object2, and the the modification to Object1 would
not be reflected in it. This is of course an unpleasant result.

create−−−−−→ TextGrid view−−−−−→ TextGrid

TextGrid ←−−−−−save Object1

←−−−−
edit Editor1

File create−−−−−→ TextGrid view−−−−−→ TextGrid
←−−−−−save Object2

←−−−−
edit Editor2

Figure 5: Relations among a File, Objects, and Editors (without Restriction 1)

The underlying reason for this is that Praat Objects are, once created, in-
dependent from one another, regardless of the sources; there are no links
between Object1 and Object2, even though they were created from the same
TextGrid file (cf. Figure 5). Thus, the resultant TextGrid would be the most
recently saved Object (i.e., Object2).

Praat Launcher does not cause this type of problem. Since, thanks to
Restriction 1, Praat Launcher creates only one Object per TextGrid file, and
it opens the already existing Object if it exists, all modifications on two (or
more) TextGridEditors are reflected in the Object (cf. Figure 6).
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view−−−−−→ TextGrid

TextGrid create−−−−−→ TextGrid
←−−−−
edit Editor1

File ←−−−−−save Object view−−−−−→ TextGrid
←−−−−
edit Editor2

Figure 6: Relations among a File, Objects, and Editors (with Restriction 1)

A few caveats:

• You cannot have more than five editors with one object (this is a re-
striction of Praat, not Praat Launcher).

Figure 7: Praat Warning

If Praat issues this warning, close unnecessary TextGridEditors (or quit
Praat altogether).

• The judgment of whether or not the TextGrid Object in question al-
ready exists in the Object Window depends exclusively on their names.
This criterion is, in fact, excessively stringent; it follows that Praat
Launcher cannot open two or more TextGrid files which are located in
different directories but (happen to) have the same name. That is in-
deed a negative repercussion of Restriction 1, but hopefully not a fatal
one.

• Praat Launcher issues a message when it tries to open the already
existing TextGrid Object.

If the selected Object is not the one you intend, press “stop”. The
message can be suppressed by setting the parameter “Message about

the Existing Object” to “OFF” on the Setting Sheet, though it is not
recommended.
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Figure 8: Praat Launcher Message

6.2 Prohibition of the Use of Non-ASCII Characters
in Filenames/Pathnames (in Windows)

In Windows, Praat Launcher cannot properly deal with files whose names
or pathnames contain non-ASCII characters (this is due to sendpraat, not
praat; praat per se can handle them properly). Thus,

Restriction 2 (in Windows):
Praat Launcher explicitly bans the use of non-ASCII characters in the
values of the following items:

– Setting Sheet

∗ Folder containing the TextGrid Files

∗ Folder containing the Sound Files

∗ TextGrid File Extension

∗ Sound File Extension

∗ Sound Filebasename Suffix 1

∗ Sound Filebasename Suffix 2

∗ Other File(s) to be read

– Data Sheet

∗ Column/Field for the filebasename

∗ Column/Field for Sound Filebasename Suffix

Unlike Windows, Macintosh is free from this restriction.

7 How to Open a Pair of TextGrid and Sound

Files with Different Basenames

Thus far, we have assumed that the sound files share their basenames with the
corresponding TextGrid files (e.g., sample1.wav and sample1.TextGrid).
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Though this assumption is fairly reasonable, it is not always the case. A
typical example can be found in the case of dialogue data. Suppose that you
have a set of files like below:� �

• dialog01.TextGrid

• dialog01.wav (multi-channel)

• dialog01-L.wav (left-channel only)

• dialog01-R.wav (right-channel only)� �
That is, there are two or more sound files (dialog01-L.wav, dialog01-R.wav,
and dialog01.wav), while there is only one corresponding TextGrid file
(dialog01.TextGrid).

Praat launcher can deal with “mismatched” pairs of files if the following
relation holds between the filenames:

sound filebasename = TextGrid filebasename + suffix

In the examples above, the suffix of dialog01-L.wav is “-L”; similarly, the
suffix of dialog01-R.wav is “-R”.� �

dialog01 . TextGrid

dialog01 -L . wav

dialog01 -R . wav

suffix extension︸ ︷︷ ︸
basename� �

Praat Launcher provides two ways to open this kind of “mismatched”
pair.

The first is to specify the suffixes in the Setting Sheet Sound Filebasename

Suffix 1 and Sound Filebasename Suffix 2, and execute one of the fol-
lowing commands in Praat Launcher’ Praat menu

• TextGrid+Sound[suffix1]

• TextGrid+Sound[suffix2]

• Sound[suffix1]

• Sound[suffix2]
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These commands try to open the sound files whose basenames consist of the
TextGrid basename and the suffixes specified in the Setting Sheet.

The second way is to embed the suffix to each row in the Data Sheet4,
and set the parameter Column/Field for Sound Filebasename Suffix in
the Setting Sheet to the column for the suffixes.

When the two ways compete, the first way is preferred over the sec-
ond. But if the current value of the suffix in the Setting Sheet (i.e., Sound
Filebasename Suffix 1 or Sound Filebasename Suffix 2) is null, the
second way comes into effect.

8 Tips

• If all the sound files you have share their basenames with the cor-
responding TextGrid files, nullify the values of Sound Filebasename

Suffix 1 and Sound Filebasename Suffix 2 in the Setting Sheet.
When they are null, “TextGrid+Sound[suffix1] (C-S-o)” and “TextGrid+Sound
[suffix2] (C-S-/)” in the menu works in exactly the same way as
“TextGrid+Sound (C-S-v)”.

• Consider the use of functions of Excel. For example,

– sort

– filter

– change the color of cells (rows)

– make notes on the current sheet (other than the cells for the file-
basenames and timestamps, of course)

• If you find optimal values for the parameters, change the original de-
fault values defined in the add-in (source file); it would alleviate your
burden to make/rewrite the Setting Sheet every time (see Appendix
A.1 for details).

4Incidentally, in the default settings in Excel, a string which begins with “-”(minus)
will cause an error within the cell (“#names?”), because Excel tries to take it as a formula.
When you embed suffixes which begin with “-” to the Data Sheet, put an apostrophe in
front, or change the cell property to “text” beforehand.
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9 List of Parameters

9.1 Folders & Files

⋄ Location of praat

⋄ Location of sendpraat

– Specify the intended executable files with their absolute paths.� �
[correct] C:\praat\praat.exe

[wrong] praat.exe ;;path missing

[wrong] C:\praat ;;filename missing� �
– If Praat/sendpraat specified here does not work, confirm their be-

haviors on the Command Prompt/Terminal (see setup prln.pdf).

⋄ Folder containing the TextGrid Files

⋄ Folder containing the Sound Files

– Specify the directories where the TextGrid/sound files are kept.

– The path delimiter at the end can be omitted.� �
[correct] C:\speech\sample\TextGrid

[correct] C:\speech\sample\TextGrid\� �
– [Windows] Non-ASCII characters are prohibited.

⋄ TextGrid File Extension

⋄ Sound File Extension

– [Windows] Non-ASCII characters are prohibited.

⋄ Sound Filebasename Suffix 1

⋄ Sound Filebasename Suffix 2

– These values come into effect when “TextGrid+Sound[suffix1]”
and “TextGrid+Sound[suffix2]” in the “Praat” menu are exe-
cuted (see §7).

– They open sound files whose basenames consist of the TextGrid
filebasenames and the values specified here.
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∗ For example, if the TextGrid filebasename is “sample”, and
the value of “Sound Filebasename Suffix 1” is “-L”, then
the command “TextGrid+Sound[suffix1]” opens the pair of
sample.TextGrid and sample-L.wav.

– These values can be null. In that case, “TextGrid+Sound[suffix1]”
and “TextGrid+Sound[suffix2]” do exactly the same job as “TextGrid+Sound”.

– [Windows] Non-ASCII characters are prohibited.

⋄ Other File(s) to be Read

– Files specified here will be read additionally.

– Any types of files (e.g., .praat, .Pitch) can be specified here,
as long as they can be read by the Praat’s Read from file...

command.

– This parameter is optional; the value can be null.

– If a non-existent file is specified (or the file specified lacks the abso-
lute path), Praat Launcher simply neglects it, without generating
an error.

– The files specified here are just read to the Object Window; they
are neither opened with an Editor, nor executed automatically.

– Multiple files can be specified by using comma “,”.� �
C:\script\foo.praat,C:\script\bar.praat� �

In the example above, foo.praat and bar.praat will be read.

– You can use the string “<BASENAME>” and “<SUFFIX>” for the
current basename and suffix.� �
C:\sample\wav\pitch\<BASENAME>.Pitch� �

When the current basename is “sample01”, C:\sample\wav\pitch\
sample01.Pitch will additionally be read to the Object Window.

– [Windows] Non-ASCII characters are prohibited.

9.2 Praat: Start, Browse, & Play

⋄ Sound Object Class
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– Select either “Sound” or “LongSound” from the pulldown menu.

– If you open relatively long sound files, select the latter.

∗ Though some long sound files can be read, it takes time 5.

⋄ Automatic Play

– Select either “ON” or “OFF” from the pulldown menu.

– If “ON” is selected, Praat Launcher plays the selected area auto-
matically.

⋄ Message about the Existing Object

– Select either “ON” or “OFF” from the pulldown menu.

– If “ON” is selected, Praat Launcher issues a message when it tries
to open an already existing TextGrid Object.

– See §6.1 for details.

⋄ [Interval Specified] Browse: Preceding Margin

⋄ [Interval Specified] Browse: Following Margin

– Specify the widths of the margins (i.e., the areas which are dis-
played but not selected).

– These values are used when two timestamps (i.e., an interval) are
designated on the active row of the Data Sheet.

– The unit is sec (second).

⋄ [Point Specified] Select: from the Specified Point Minus...

⋄ [Point Specified] Select: to the Specified Point Plus...

⋄ [Point Specified] Browse: Preceding Margin

⋄ [Point Specified] Browse: Following Margin

– Specify the widths of the selected area and the margins.

– These values are used when only one timestamp (i.e., a point) is
designated on the active row of the Data Sheet.

– The unit is sec (second).

5For the differences between Sound and LongSound Objects, consult Praat’s
Help menu, or http://www.fon.hum.uva.nl/praat/manual/Sound files 3 Files
that Praat can read.html.

http://www.fon.hum.uva.nl/praat/manual/Sound_files_3__Files_that_Praat_can_read.html
http://www.fon.hum.uva.nl/praat/manual/Sound_files_3__Files_that_Praat_can_read.html
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Figure 9: Interval Specified

9.3 Check: Threshold

⋄ Max Duration

– Praat Launcher aborts the current job if (i) the difference be-
tween the values of timestamp 1 and timestamp 2 on the active
row of the Data Sheet, or (ii) the sum of the values “Select:
from the Specified Point Minus...” and ”Select: to the

Specified Point Plus...” on the Setting Sheet, is larger than
the one specified here.

– The unit is sec (second).

9.4 Excel: Worksheet

⋄ Column/Field for Filebasename

⋄ Column/Field for Timestamp 1

⋄ Column/Field for Timestamp 2

⋄ Column/Field for Sound Filebasename Suffix

– Specify the Columns/Fields for filebasename, timestamp 1, times-
tamp 2, and Sound Filebasename Suffix on the Data Sheet.
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Figure 10: Point Specified

– You can either select the values from the pulldown menu, or
rewrite them directly.

– Not only column alphabets (e.g., A, B, ... AA, ...), but also row
numbers (e.g., 1, 2, ... 27, ...) are available.

– The items prepared in the pulldown menu only go up to “AZ”. If
you specify a larger column/field, input it manually.

– You can specify the same value in “Column/Field for Timestamp

1” and “Column/Field for Timestamp 2”, if the active row on
the Data Sheet contains only one timestamp.

– For “Column/Field for Sound Filebasename Suffix”, see §7.

– The value of “Column/Field for Sound Filebasename Suffix”
is ignored when (i) commands whose name contains [suffix1] or
[suffix2] are executed, and (ii) the value of “Sound Filebasename

Suffix 1/2” is not null.

⋄ Font Color

– Select the color (BLUE, BROWN, RED, PINK, BLACK, or (AsIs))
from the pulldown menu.
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– When Praat Launcher starts, it changes the font color of the active
row to the value specified here.

– If you do not want the font color to change, select (AsIs).

10 Disclaimer

The author expressly disclaims all liability, loss or risk incurred as a direct
or indirect consequence of the use of Praat Launcher.

11 License

You may use, copy, modify, and redistribute Praat Launcher provided that
you believe it contributes to phonetic studies.
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Appendix

A Customizing the add-in

Praat Launcher will be more useful if you modify the source code. Even a
superficial knowledge of programming languages (not necessarily Excel VBA)
will suffice, as far as the modifications described below are concerned.

To edit the source code of Praat Launcher, start Visual Basic Editor first.

• Click the Developer tab→ the Visual Basic ribbon (Excel 2007), or
select Excel menu’s Tools→ Macros→ Visual Basic Editor (Excel
2003, 2004)

– [Excel 2007] If the Developer tab does not appear in Excel win-
dow, follow the procedure below:

1. Click the Office button, and then click Excel Options.

2. Click Personalize.

3. Click to select the Show Developer tab in the Ribbon check
box.

4. Click OK.

Then, select the code in the Project Window.

• Double-click VBA Project(praat launcher.*.xla) in the Project Win-
dow (at the upper left of the Visual Basic Editor) → Modules →
launcher

Figure 11: Project Window
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A.1 Altering the Default Values of the Parameters

If the optimal values of the parameters in your environments are (relatively)
constant, you may alter the default values.

1. Search (C-f) the function below:� �
Function ParamSetting(number As Long) As Variant� �

2. Alter the values in the right edge of the extremely long statements.

(omitted) & "Location of praat " & ll & "C:\praat\praat.exe "

(omitted) & "Location of sendpraat " & ll & "C:\praat\sendpraat.exe "

(omitted) & "Folder containing the TextGrid Files " & ll & "C:\sample\TextGrid "

(omitted) & "Folder containing the Sound Files " & ll & "C:\sample\wav "

(omitted) & "TextGrid File Extension " & ll & "TextGrid "

(omitted) & "Sound File Extension " & ll & "wav "

(omitted) & "Sound Filebasename Suffix 1 " & ll & "-L "

(omitted) & "Sound Filebasename Suffix 2 " & ll & "-R "

(omitted) & "Other File(s) to be Read " & ll & " "

(omitted) & "Sound Object Class " & ll & "LongSound "

(omitted) & "Automatic Play " & ll & "OFF "

(omitted) & "Message about the Existing Object " & ll & "ON "

(omitted) & "Browse: Preceding Margin " & ll & "0.7 "

(omitted) & "Browse: Following Margin " & ll & "0.7 "

(omitted) & "Select: from the Specified Point Minus... " & ll & "0.03 "

(omitted) & "Select: to the Specified Point Plus... " & ll & "0.03 "

(omitted) & "Browse: Preceding Margin " & ll & "1.0 "

(omitted) & "Browse: Following Margin " & ll & "1.0 "

(omitted) & "Max Duration " & ll & "60 "

(omitted) & "Column/Field for Filebasename " & ll & "A "

(omitted) & "Column/Field for Timestamp 1 " & ll & "B "

(omitted) & "Column/Field for Timestamp 2 " & ll & "C "

(omitted) & "Column/Field for Sound Filebasename Suffix" & ll & "(none) "

(omitted) & "Font Color " & ll & "BLUE "︸ ︷︷ ︸
default values

N.B. Spaces at the end of the strings are not significant, and you do
not have to align the final double quotations.

3. Save the code (C-s).

4. Go back to Excel, and delete (remove) or rename the Setting Sheet.

5. Execute Praat Launcher to see if it works as you intend.

Of course, even if you alter the default values, you can change the values
(temporarily) at any time by creating and rewriting the Setting Sheet.
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A.2 Reassigning/Add Shortcut Keys

To change the keybinds of the shortcut keys:

1. Search (C-f) for the following subroutine:� �
Sub auto open()� �

2. Modify the statements below:� �
’ ======================================================

’ Shortcut Keys

’ ======================================================

Application.OnKey "+^{v}", "praat_TGSound"

Application.OnKey "+^{o}", "praat_TGSound_suffix1"

Application.OnKey "+^{/}", "praat_TGSound_suffix2"

Application.OnKey "+^{-}", "praat_Sound"

Application.OnKey "+^{^}", "praat_Sound_suffix1"

’Application.OnKey "+^{\}", "praat_Sound_suffix2"

’Application.OnKey "+^{n}", "praat_TG"� �
N.B. The last two lines are commented out (with an apostrophe in
front).

3. Save the code (C-s).

4. Go back to Excel, and restart it.

B Release History

• Version 1.5.0 (Nov. 3, 2011)

– Modified the Setting Sheet.

∗ Added:

· Message about the Existing Object

· Column/Field for Sound Filebasename Suffix

(Praat Launcher reads the value of suffixes on the Data
Sheet if the column is specified here)



Praat Launcher: Manual 22

∗ Deleted:

· Max Time (instead, Praat Launcher checks if the value of
timestamp 1 on the Data Sheet exceeds the total dura-
tion of the sound file, immediately after reading the sound
file)

∗ Changed:

· Other File(s) to be read [formerly Praat Script File(s)]
(Praat Launcher now accepts any file types, and recog-
nizes “<BASENAME>” and “<SUFFIX>” as the current TextGrid
basename and suffix, respectively)

• Version 1.4.0 (Jan. 18, 2011) [Unpublished, internal use only]

– Modified the Setting Sheet.

∗ Added the following parameters:

· Sound Filebasename Suffix 1

· Sound Filebasename Suffix 2

· Column/Field for Filebasename

· Column/Field for Timestamp 1

· Column/Field for Timestamp 2

∗ Added the version number

∗ Made Column D left-aligned and text format.

– Modified some error messages.

• Version 1.3.1 (Jan. 4, 2011)

– Modified some comments.

• Version 1.3.0 (Dec. 30, 2010)

– Released on the web.

C To Do

• [Macintosh] Avoid making a temporary file in starting Praat (it is
deleted immediately after the launch).

• Optimize the code.
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